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[bookmark: _Toc432430220]Creating Drawing Objects
Word’s drawing features enables you to create a drawing composed of drawing objects such as lines, shapes, and text boxes. You can create a drawing anywhere in a document either directly onto the page or on a drawing canvas that will hold all of your drawing objects together. It is easier to create it in a blank portion of the document than in an area that contains text. If you use the drawing canvas the text is automatically moved to make space for the drawing. Once you complete the drawing, you can move it to its final location. 

[image: ]The Drawing tools in Word 2016 are located on the Insert Tab on in the Illustrations Group:

Figure 2‑1: The Illustrations Group
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[bookmark: _Ref378441974]Figure 2‑2: The Drawing Tools
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Creating Lines and Shapes
Lines and shapes are the basic components of drawings. You can create lines and shapes by using the Line, Arrow, Rectangle, and Oval buttons.  Additionally, you can use the group to insert predefined shapes, such stars, banners, and arrows, into a drawing.

After you select a shape and move the mouse pointer onto the page, the pointer changes into a cross hair. To draw an object, position the pointer where you want to begin the object and then drag the mouse in the desired direction. Holding the SHIFT key while drawing with the Line tool produces a horizontal or vertical line; holding the SHIFT key while drawing with the Rectangle or the Oval tool produces a square or a circle, respectively.
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	Text box
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	Rectangle and Oval
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	Line and arrow
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	Freehand Scribble





To display the Drawing options:

1.	On the Insert Ribbon, Illustration Group, click the Shapes button.
	
To create a line or shape:

1.	From the Shapes group, click the Line, Arrow, Rectangle, or Oval button from the Recently Used sub group.
2.	In the drawing, position the mouse pointer where you want to begin the object.
3.	Drag the mouse to draw the object.
or
3.	As appropriate, press and hold SHIFT as you drag the mouse to draw a horizontal, vertical, or proportional object.

To create a Basic Shape directly on the page:

1.	From the Shapes group, click the desired shape.
2.	In the drawing, position the mouse pointer where you want to begin the object.
4.	Drag the mouse to draw the object.
or
4.	Press and hold SHIFT as you drag the mouse to draw a proportional object.




	To create a shape using the Drawing Canvas:


Format Drawing Tools Ribbon

1.	From the Shapes group, click the New Drawing Canvas button.
2.	The Formatting Shapes ribbon then appears with the Shapes group appearing at the left of the ribbon.

[image: ]

3.	Select the shape from the Insert Shapes group
4.	Create the shape as before – but inside the drawing canvas

To create a freehand drawing object:

1.	From the Shapes group.
2.	On the Lines palette, select Scribble.
3.	In the drawing, position the mouse pointer where you want to begin the object.
4.	Drag the mouse to draw the desired shape.

Note: If desired, to close a freehand drawing object, release the mouse button near the object’s starting point when dragging.





In the following exercise, you will create lines and shapes.

Refer to Figure 2‑1 for assistance as you create your drawing.

		1.
	Open Disney.docx
	

		2.
	Make sure the ruler is displayed. (Click the Ruler button at the top of the vertical scroll bar).
	

		3.
	Switch to the Insert Ribbon to display the Illustrations group.
	The Shapes button appears in the Illustrations group.

		4.
	Place the insertion point on the blank page at the end of the document
	

		5.
	From the Shapes group, Recently Used Shapes section, click the Rectangle button
	The mouse pointer changes into a cross hair in the document window.

		6.
	On the blank page at the bottom of the document, position the mouse pointer even with the 1" mark on both the horizontal and vertical rulers
	

		7.
	Drag the mouse until the pointer is even with the 4" horizontal and 6" vertical marks
	A rectangle is created and the Format [shapes] ribbon appears

		8.
	Zoom to 50% and use the scroll bars, if necessary, to position the entire rectangle in the document window
	

		9.
	From the Shapes group, Recently Used Shapes section, click the Oval button
	

		10.
	In the drawing, position the mouse pointer even with the 2" mark on the horizontal ruler and the 1.5" mark on the vertical ruler
	

		11.
	Press and hold SHIFT as you drag the mouse until the pointer is even with the 3" mark on the horizontal ruler
	A circle is created.

		12.
	From the Insert Shapes group in the Format ribbon click the Line button
	

		13.
	In the drawing, position the mouse pointer on the left edge of the rectangle even with the 3" mark on the vertical ruler
	

		14.
	Press and hold SHIFT as you drag horizontally to the right edge of the rectangle
	A horizontal line is created.







[bookmark: _Ref378441914]Figure 2‑3: The New Drawing—Creating Lines and Shapes Exercise








		15.
	From the Insert Shapes group in the Format ribbon click the Down Ribbon in the Stars and Banners sub group (third from the right on the first row)
	

		16.
	In the drawing, position the mouse pointer even with the 2" mark on the horizontal ruler and the 3.5" mark on the vertical ruler
	

		18.
	Drag the mouse until the pointer is even with the 3" mark on the horizontal ruler and the 3.75" mark on the vertical ruler
	A banner is created.

		19.
	Zoom to 200% and use the scrollbars, if necessary, to position the bottom line of the rectangle near the bottom of the document window
	

		20.
	From the Insert Shapes group in the Format ribbon click the Scribble button
	

		21.
	In the drawing, along the bottom right of the rectangle, drag to write your first name, making sure you do not release the mouse button until you complete your entire name
	

		22.
	Zoom to 100% and position the top of the drawing at the top of the document window
	

		23.
	Save the document as Disney 1.docx
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Creating Text Boxes
You can type text into a drawing by entering the text in a text box. You insert a text box by clicking the Text Box button on the Insert Menu, text group, text box and then selecting the box required. After you insert the text box, Word moves the insertion point inside the box. You can then format and type text in the text box.


To create a text box:

1.	From the Insert ribbon, Text Group, Text Box commands, click the Text Box button.
2.`Select the style of text box required
or
2.	In the drawing, position the mouse pointer where you want to begin the text box.
3.	Drag the mouse to draw the text box.
4.	Format and type the text as desired.



In the following exercise, you will create a text box.

		1.
	Make sure the top of the drawing on the third page of Disney 1.doc is displayed in the current window
	

		2.
	From the Shapes group select the Text Box button
	

		3.
	Position the mouse pointer even with the 4.5" mark on the horizontal ruler and the 2" mark on the vertical ruler 
	

		4.
	Drag the mouse until the pointer is even with the 6" mark on the horizontal ruler and the 2.5" mark on the vertical ruler
	A text box is created, and the insertion point moves inside the box.

		5.
	Using 8 point type and the Center paragraph alignment, type Visit me at Disney
	The new text is placed in the text box.

		6.
	Click outside the Text Box to deselect 
	

		7.
	Save the document
	

		8.
	Zoom to 50% and position the entire drawing in the document window
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Enhancing Drawing Objects
The Formatting ribbon provides tools that enable you to apply fill colours to shapes and line colours to lines. You can also apply textures, gradients, and patterns to shapes, and dash formats and arrowheads to lines. Additionally, you can use 3-D effects to make objects appear three dimensional.

[image: ]
Applying Fill and Outline Colours
You can use the Shape Styles group within the Format Ribbon to change the appearance of an object.  From this group you can select from a gallery of pre-defined styles and can also customise the colour of the fill, or the outline. Figure 2‑4 illustrates the default Shape Fill and Shape Outline command groups. 

         [image: ]   	[image: ]

[bookmark: _Ref378952773]Figure 2‑4: The Shape Fill and Shape Outline command groups
The Theme Colours and Standard Colours offer limited colour selections. Instead of choosing a colour from one of these palettes, you might want to select a fill or line colour from the more extensive standard palette, illustrated in Figure 2-4. You can access this palette by choosing the More Fill Colours or More Outline Colours option in each of the command groups.


[bookmark: _Ref378442401][image: ]

[bookmark: _Ref378952853]Figure 2‑5: The Fill and Line Colour Standard Palette

Before you can apply enhancements such as colours to an object, you must select the object. An object is selected if small squares appear around its corners and sides. By default, Word automatically selects a drawing object when you first create it. You can select an existing drawing object by clicking it with the mouse. Word lets you deselect an object by clicking outside the object or by clicking another object.

Once your object is selected you can preview the effect of your chosen colour by moving your mouse over the colour.  As you hover your mouse over your choice the object on the page change to show the previewed colour before you click on it to select it.  Ensure that your object is to the right of the page otherwise the effect will be hidden underneath the colour options.



To select a drawing object:

1.	Position the mouse pointer over the object.
2.	Click the mouse.

To deselect a drawing object:

1.	Click outside the object.
or
1.	Click any other object.

To apply a default fill or line colour:

1.	Select the desired drawing object.
2.	From the Format ribbon choose the Shapes Styles group, choose Shape Fill or Shape Outline and select a fill colour from Standard Colour or Theme Colour and click on the chosen colour.
	
or
2.	Right click the object and choose Format Autoshape. Select the Colours and Lines tab and choose the drop-down arrow for either Fill or Line Colours.  Select the colour from the Standard Colour or Theme Colour options.


To apply a standard fill or line colour:

1.	Select the desired drawing object.
2.	From the Format ribbon choose the Shapes Styles group, choose Shape Fill or Shape Outline and select a fill colour from More Colours, Standard tab and click on the chosen colour.
	or
2.	Right click the object and choose Format Shape. The Shape options pane will appear to the right of the screen.  Select the Fill and Line option, Effects option or Layout and Properties option. 
4.	Choose OK.

Format Shape Pane showing options for text effects, Fill Effects and Text Box effects
[image: ]






In the following exercise, you will apply fill and line colours.

		1.
	Make sure the drawing in Disney 1.docx is displayed in the current window
	

		2.
	In the drawing, position the mouse pointer over the circle 
	

		3.
	Click the mouse
	The circle is selected.

		4.
		From the Format ribbon, Shape Styles command group choose Shape Fill drop-down palette, select Red Accent 2 (first row of Theme Colours)
	The circle is filled with the rose colour.

		5.
	Click an empty area of the page
	The circle is deselected.

		6.
	In the drawing, select the rectangle
	

		7.
		From the Format ribbon, Shape Styles command group choose Shape Outline drop-down palette More Outline Colours
	The Colours dialog box appears.

		8.
	On the Standard tab, click any shade of blue
	

		9.
	Choose OK
	The lines of the rectangle are coloured blue.

		10.
	Deselect the rectangle
	




Applying Fill Effects
You can use fill effects to apply designs to the interiors of shapes in your drawing. Word provides a variety of fill effects from which you can choose. You can choose from Gradients, Textures, Pictures or Patterns. The Pattern fill effect window allows you to apply shading, lines, dashes, and other patterns. The Texture tab allows you to apply textures such as marble, wood, and paper. The Gradient tab allows you to apply variations of shading and with Picture you can add a picture stored on your PC.  From the Pattern window you can access the More Gradients, and More Textures options from the initial command group.

[image: ]
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[bookmark: _Ref378442482]Figure 2‑6: The Shape Fill Commands Pattern, Texture, and Gradient options




To apply a fill effect:

1.	Select the desired drawing object.
2.	From the Format ribbon, Shape Styles command group choose Shape Fill drop-down and choose either Gradient, Texture, Pattern or Picture.
3.	From the options shown select the desired setting(s).
5.	Choose OK.



In the following exercise, you will apply fill effects.

		1.
	Make sure the drawing in the Disney 1.docx is displayed in the current window
	

		2.
	In the drawing, select the circle
	

		3.
	Format ribbon, Shape Styles command group choose Shape Fill group
	

		4.
	Select the Pattern options
	The Pattern options appear.

		5.
		In the Pattern palette, select Light vertical (first row, fourth column)
	

		6.
	Choose OK
	The dialog box closes, and the circle is filled with the pattern. The circle remains selected.

		7.
	Choose the Shape Fill group and click on Texture
	The Texture options appear.

		8.
		From the Texture options, select White marble (third row, second column), and then choose OK
	The dialog box closes, and the circle is filled with the texture. The circle remains selected.

		9.
	Choose the Shape Fill group and click on Gradient 
	The Gradient options appear.

		10.
		From the Gradient options, select either Light or Dark Linear Down
	The Gradient option is applied and the circle remains selected

		11.
	Select the More Gradients option form the Shape Fill, Gradients group.
	

		12.
		Select the Preset radio button, and the Fire colourway in the PreSet Colours box.
	The dialog box closes, shows the Fire colourway.

	13.
	Choose Shading Style Diagonal Down and the top right Variant
	The display changes to show a preview of Fire scheme Diagonal Down variant

		13.
	Choose OK
	

	14.
	Deselect the Circle
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Applying Line Effects
You can use line effects to customize the appearance of the lines in your drawing. Word lets you modify the widths of or apply dash effects to single lines or to the perimeter lines of shapes. Additionally, you can add arrowhead styles to single lines.


To apply a dash or line style:

1.	Select the desired drawing object.
2.	From the Formatting ribbon, Shape Styles group, choose the Outline Fill drop down and select a dash style from the Dashes options.

[image: ]

		
To apply an arrow style:

1.	Select the desired line.
2.	From the Formatting ribbon, Shape Styles group, choose the Outline Fill drop down and select an arrow style from the Arrows options.





[image: ] 

In the following exercise, you will apply line effects.

		1.
	Make sure the drawing in the Disney 1.docx is displayed in the current window
	

		2.
	In the drawing, select the rectangle
	

		3.
		From the Format ribbon, Shapes Style group, select Shape Outline and choose Weight group.  Select 3pt, Solid
	The lines of the rectangle become thicker.

		4.
	In the drawing, select the horizontal line
	

		5.
		From the Shapes Style group, select the Shape Outline group and from the Dash Style options, select Square Dot (the third style)
	The line becomes dashed and remains selected.

		6.
		From the Shapes Style group, select the Shape Outline group and from the Arrow Style options, select Arrow Style 7
	Arrow heads are applied to the line.

		7.
	Deselect the line
	

		8.
	Save the document
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Applying and Modifying 3-D Effects
You can apply a three dimensional look to any drawing object by selecting an effect from the 3-D palette. The 3-D Settings options, which you can access by choosing the palette’s 3-D Settings option, enables you to modify the appearance of 3-D objects. Figure 2‑5 illustrates the 3-D Effects options.

	[image: ]Vertical and Horizontal Tilt options

	


[bookmark: _Ref378442569]
[bookmark: _Ref382195716]Figure 2‑7: The 3-D Shape Effects group


To apply a 3-D effect:

1.	Select the desired drawing object.
2.	From the Format Ribbon select the Shape effects group and 3‑D effects drop down options.
3.	Click one of the desired 3-D shapes from the list.

To modify 3-D settings:

1.	Select the desired drawing object.
2.	From the 3-D options, choose any Colour, Depth, Direction, Lighting or Surface options
	or
3.	From the Format Ribbon select the Shape effects group and 3‑D Rotation drop down options. Click the 3-D Rotation Options. Click the chosen tilt angle button from the list until the desired effect is achieved.



In the following exercise, you will apply and modify 3-D effects.

		1.
	Make sure the drawing in the Disney 1.doc is displayed in the current window
	

		2.
	In the drawing, select the rectangle
	

		3.
	From the Format ribbon and 3‑D Shape Effects group, select 3-D Style 1 (first row, first column)
	The rectangle appears three dimensional and remains selected.

		4.
	From the Format ribbon and 3‑D Effects group, click the Tilt Up button 3 times
	The rectangle tilts and remains selected.

		5.
	From the 3-D Effects group, click the Tilt Down button 6 times
	The rectangle is now tilting down

		6.
	On the 3-D Settings toolbar, choose 3-D Style 5 from the Perspective group
	The perspective of the rectangle changes.

		7.
	Deselect the rectangle
	

		8.
	Save the document
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Manipulating Drawing Objects
Once you create the desired drawing objects, you can move, copy, size, and rotate them within your drawing. Word also lets you group multiple objects together so that you can manipulate them as a single object. After you complete your drawing, you can place it at the desired location in your document.

Moving and Copying Drawing Objects
To move an object, drag the object to a new location in the drawing. If you need several objects of the same shape, you can copy an object by pressing and holding CTRL while you drag the object.

Word aligns objects on a grid, which is an invisible network of lines that covers the drawing area. When you drag a drawing object close to a gridline or to an intersection of gridlines, the object is pulled into alignment. This pulling effect is called snap to grid. If you want to position objects freely, you can turn off the snap to grid feature in the Drawing Grid dialog box, illustrated in Figure 2-8. 


[image: ]

[bookmark: _Ref378442622]Figure 2-8: The Drawing Grid Dialog Box



To activate or deactivate the snap to grid feature:

1. From the Format Ribbon select the Arrange group.
2. Click the Align button drop down arrow. [image: ] 
3. Select Grid Settings from the list.
4. Choose OK.

To move a drawing object:

1.	Position the mouse pointer over the object.
2.	Drag the object to the new location.

To copy a drawing object:

1.	Position the mouse pointer over the object.
2.	Press and hold CTRL as you drag the object to a new location.





In the following exercise, you will move and copy drawing objects.

		1.
	Make sure the drawing in the Disney 1.docx is displayed in the current window
	

		2.
		From the Format Ribbon, select the Arrange group. Click the Align button. Select Grid setting.
	The Drawing Grid dialog box appears.

		3.
	Deselect the Snap to grid check box if necessary
	

		4.
	Choose OK
	The dialog box closes, and the snap to grid feature is deactivated.

		5.
	In the drawing, position the mouse pointer over the banner
	

		6.
		Drag the banner until it is centered between the horizontal line and your name
	The banner is moved.

		7.
	Position the mouse pointer over the circle
	

		8.
		Press and hold CTRL as you drag the circle to the top left corner of the rectangle

	A copy is made of the circle.

		9.
	Deselect the circle
	

		10.
	Compare your drawing to Figure 2-9
	







[bookmark: _Ref378874888]
[bookmark: _Ref380379454]Figure 2‑9: The Revised Drawing—Moving and Copying Exercise
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Sizing and Rotating Drawing Objects
By dragging one of the square shaped sizing handles that appear around an object when it is selected, you can change the size of the object to suit your needs. When you drag a sizing handle, the proportions of the object can become distorted. To size an object proportionally, press and hold SHIFT while you drag a corner sizing handle. 

[image: rotate]To rotate an object, you can use the Free Rotate button that appears on the drawing. An object can be rotated when a small green circle called a rotating handle appears on its perimeter. When you drag a rotating handle, you see the outline of the object as it rotates around its central axis point as illustrated in Figure 2‑8Direction of mouse drag on the rotation handle


[bookmark: _Ref190492496]Figure 2‑10: The Rotate Handle in action

You can also choose from 4 pre-defined rotation options as illustrated in Figure 2-11
.
[image: ]

[bookmark: _Ref190492467]Figure 2‑11: Rotation options in the Arrange command group on the Format ribbon



To size a drawing object:

1.	Select the desired object.
2.	Position the mouse pointer over one of the object’s sizing handles.
3.	When the pointer becomes a two way arrow, drag the sizing handle until the object is the desired size.
	or
3.	When the pointer becomes a two way arrow, press and hold SHIFT while dragging a corner sizing handle to size the object proportionally.

To rotate a drawing object:

1.	Select the desired object.
2.	On the Drawing, click the Free Rotate button.
3.	Position the mouse pointer over one of the object’s rotating handles.
4.	When the pointer becomes a circled arrow, drag the rotating handle until the object is in the desired position.
or

2. Select one of the Rotation Options from the Arrange command group on the Format ribbon




In the following exercise, you will size and rotate drawing objects.

		1.
	Make sure the drawing in the Disney 1.docx is displayed in the current window
	

		2.
	In the drawing, select the circle in the top left corner of the rectangle
	

		3.
	Position the mouse pointer over one of the circle’s corner sizing handles
	The pointer becomes a two way arrow.

		4.
	Press and hold SHIFT while dragging the sizing handle until the circle is approximately ½" in diameter
	The circle’s size is decreased.

		5.
	Change the smaller circle’s fill colour to white (last row, last column in the fill palette), and then move the smaller circle so that it is centered inside the larger circle
	

		6.
	In the drawing, select the banner
	

		7.
		Click the Rotate handle on the object
	.

		8.
		Position the mouse pointer over the banner’s rotating handle
	The pointer becomes a circled arrow.

		9.
		Drag the rotating handle so that the banner is upside down from its original position
	The banner is rotated 180 degrees.

		10.
	Position the mouse pointer on a corner sizing handle of the banner and drag until the banner is approximately 2” wide and 1” tall, and then move the banner to the center of the lower rectangle
	

		11.
	Move the text box to the center of the banner
	

		12.
	Deselect the text box
	

		14.
	Compare your drawing to              Figure 2-12
	

		15.
	Save the document
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[bookmark: _Ref382195881]             Figure 2‑12: The Revised Drawing—Sizing and Rotating 
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Grouping and Ungrouping Drawing Objects
Grouping objects makes the objects function as a single unit. This enables you to move, size, or enhance multiple objects in a single operation. If you find that you need to go back and work with individual objects in a group, you can ungroup the objects.

To group objects, you must first select them. You can select multiple objects by pressing and holding SHIFT while you click each individual object. Once objects are selected, you can group them by clicking on the Group button in the Arrange command group on the Format ribbon as illustrated in Figure 2‑13 or by choosing Group from the shortcut menu.

[image: ]

[bookmark: _Ref190492367]Figure 2‑13: Group command from the Arrange command group on the Format ribbon

You can also select objects by using the Selection Object command button from the Home ribbon as illustrated in Figure 2-14.  When this button is clicked the mouse cursor changes to an arrow.  Click and drag a lasso around the objects to select them all.

[image: ]

[bookmark: _Ref190492326][bookmark: _Ref190492275]Figure 2‑14: Select Objects command from the Editing command group on the Home ribbon

Once objects are grouped you can select the group by clicking any of its objects.









To select multiple drawing objects:

1.	Press and hold SHIFT while clicking each desired object.
or
1.	Choose the Select Objects command button from the Editing command group on the Home ribbon.  Click and drag a lasso around all the objects. 

To group drawing objects:

1.	Select the desired objects.
2.	From the Arrange command group choose Group.
	or
2.	From the shortcut menu, from the Grouping submenu, choose Group.

To deselect grouped objects:

1.	Click anywhere outside the group.

To select grouped objects:

1.	Click any object in the group.

To ungroup drawing objects:

1.	Select the grouped objects.
2.	From the Arrange command group in the Format ribbon, select Ungroup.
Or
2.	From the shortcut menu, from the Grouping submenu, choose Ungroup. 




In the following exercise, you will group and ungroup drawing objects.

		1.
	Make sure the drawing in the Disney 1.docx is displayed in the current window
	

		2.
	Press and hold SHIFT while clicking each of the circles
	Both circles are selected.

		3.
	From the Arrange command group, choose Group
	The circles are grouped.

		4.
	Click an empty area of the page
	The grouped circles are deselected.

		5.
	From the Editing command group on the Home ribbon, click the Select Objects button
	The Select Objects feature is activated.

		6.
	Position the mouse pointer outside the drawing, above the left edge of the dashed line, and drag the mouse down and to the right to enclose the entire line and the banner in the selection rectangle
	The line, the banner, and the text box are selected.

		7.
	Click the Select Objects button once again to deactivate it
	The Select Objects feature is deactivated, the three objects are still selected and the mouse returns to a normal text entry cursor shape

		8.
	Group the objects
	

		9.
	Deselect the grouped objects
	

		10.
	Click the dashed line
	The entire group is selected.

		11.
	On the Arrange command group on the Format ribbon, choose Ungroup
	The objects are ungrouped.

		12.
	Deselect the objects
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Placing Drawings within Document Text
After you complete a drawing, you can move it anywhere in your document. To move a drawing to a new position on the same page, group the objects in the drawing, and then drag the drawing to its new location. If necessary, you can move a drawing to another page in the document by using the Cut and Paste commands.

When you place a drawing in a location that contains text, the drawing might cover some of the text. You can correct this problem by changing the drawing’s wrapping options. You do this through the Text Wrapping options from the Arrange command group on the Format ribbon or from the Advanced Layout options from More Layout Options 

[image: ]

[bookmark: _Ref190493201]Figure 2‑15: The Wrap Text options from the Arrange command group on the Format ribbon
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Figure 2‑16: The Advanced Layout options






To place a drawing within document text:

1.	Group all objects in the drawing.
2.	On the Home ribbon, click the Cut button.
3.	Position the insertion point on the page where you want to place the drawing.
4.	On the Home ribbon, click the Paste button.
5.	If necessary, drag the drawing to the desired position on the page.
or
2.	Drag the drawing to the desired position on the page.

To change a drawing’s text wrapping options:

1.	Select the drawing.
2.	From the Format ribbon, choose Text Wrapping from the Command group. 
	or
2.	From the shortcut menu, choose Format Object.
3.	In the Format Object dialog box, select the Layout tab.
4.	On the Layout tab, in the Wrapping style area, select the desired option.
5.	If necessary, in the Wrap to area, select the side(s) to which you want the text to wrap or click Advanced to see the Advanced Layout dialog with more options.
6.	Choose OK.






In the following exercise, you will place a drawing within document text.

		1.
	Make sure the drawing in the Disney 1.docx is displayed in the current window
	

		2.
	Select and then group all the objects in the drawing
	The entire drawing is grouped.

		3.
	Proportionally size the drawing so that it is approximately 
1" wide
	The drawing remains selected.

		4.
	On the Home ribbon, click the Cut button
	The drawing is cut to the Clipboard.

		5.
	Position the insertion point at the top of page 1
	

		6.
	On the Home ribbon, click the Paste button
	The drawing is pasted on top of text on the first page of the document, and the drawing remains selected.

		7.
	Drag the drawing directly under the heading The Magic Kingdom towards the centre of the page
	The drawing is placed under the heading on top of text, and the drawing remains selected.

		8.
	From the Format ribbon, choose Text Wrapping command button
	The Text Wrapping options appear.

		9.
		From the Wrapping styles list select Tight
	The text wraps around the object on all sides.

		10.
		From the Wrapping styles list select More Layout Options. On the Text Wrapping tab select Right Only
	

		11.
		Choose OK
	The text wraps around the object but only on the right – leaving space on the left.

	12.
	Move the drawing in line with the left margin
	

		13.
	Deselect the drawing
	

		14.
	Zoom to Whole Page and compare your document with                Figure 2‑17
	

		15.
	Save and close the document
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[bookmark: _Ref378876785]               
Figure 2‑17: The Drawing in the Document—Placing Drawings
Section Error! Reference source not found.: Error! Reference source not found.
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[bookmark: _Toc1891381][bookmark: _Toc432430230][bookmark: Assignment]Assignment
	1.	Open About the Convention.docx.
	2.	Insert a blank page at the end of the document.
	3.	On the new blank page, draw a three inch square, and then apply the default Green line colour (number 6 in the standard row) and the default Blue fill colour (number 8 in the standard row) to the square.
	4.	Inside the square, draw a circle with a two inch diameter. Center the circle inside the square, and then apply the ¼ pt line style and a two- colour horizontal gradient fill effect to the circle.
	5.	Draw a vertical line from the center of the circle to the top edge of the circle, and then apply the default Red line colour (third row, first column) and Arrow Style 5 to the line.
	6.	Above the arrow, horizontally centered inside the square, insert a half inch wide text box containing the centered letter S in eight point type.
	7.	Proportionately insert the Sun AutoShape (end of the second row of the Basic Shapes section) at the top left corner of the square. Proportionately size the shape to measure a half inch square, and then fill it with any shade of yellow from the Standard Colours palette.
	8.	Copy the sun to each corner of the square.
	9.	Move the text box immediately below the circle, centering the text box horizontally in the square.
	10.	Rotate the arrow one hundred eighty degrees, and then center it inside the circle directly above the text box.
	11.	Apply 3-D Style 1 to the square. Change the 3-D Lighting setting to Normal.
	12.	Group the circle and the arrow, and then proportionately decrease the size of the grouped objects by a half inch.
	13.	Center the grouped objects inside the square.
	14.	Ungroup the grouped objects.
[image: ]

[bookmark: _Ref378955703]Figure 2‑18: The Completed Drawing—Self-Check Exercise
	15.	Compare your drawing to Figure 2-18, and then save the document as About the Convention1.docx.
	16.	Group all the objects in the drawing, and then proportionately size the drawing to measure one square inch.
	17.	Place the drawing on the first page of the document, and then move it so that its right edge is even with the right edge of the heading.
	18.	Wrap the text tightly around the left side of the drawing.
	19.	Using the Scribble Basic Shape (Shapes command group), sign your name at the bottom of the letter.
	20.	Compare your document to Figure 2‑19, and then close the Drawing toolbar.
	21.	Save and close the document.
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[bookmark: _Ref378956064][bookmark: _Ref381508678]Figure 2‑19: The Completed Document—Self-Check Exercise
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